Copyright is owned by the Author of the thesis. Permission is given for a copy to be downloaded by an individual for the purpose of research and private study only. The thesis may not be reproduced elsewhere without the permission of the Author.
Effectiveness of Text-based Mobile Learning Applications: Case Studies in Tertiary Education

A Thesis

Presented to

The Academic Faculty

By

Lei (Pluto) Wang

Under the Supervision of

Dr. Hokyoung Ryu

Submitted in partial fulfilment of the requirements for the Degree Master of Information Sciences in Information Technology

Massey University

30th April. 09
ABSTRACT

This research focuses on developing a series of mobile learning applications for future "beyond" classroom learning environments. The thesis describes the general use pattern of the prototype and explores the key factors that could affect users’ attitudes towards potential acceptance of the mobile learning applications. Finally, this thesis explores the user acceptance of the mobile learning applications; and investigates the mobility issue and the comparison of applying learning activities through mobile learning and e-learning.
# TABLE OF CONTENTS

ABSTRACT…………………………………………………………………………………………………..i

TABLE OF CONTENTS……………………………………………………………………………………iii

LIST OF FIGURES ………………………………………………………………………………………vii

LIST OF TABLES…………………………………………………………………………………………ix

STATEMENT OF ACADEMIC INTEGRITY ……………………………………………………………xi

ACKNOWLEDGEMENTS …………………………………………………………………………………….xiii

Chapter 1: Introduction and Background ……………………………………………………………...1
  1.1 Introduction to the Study …………………………………………………………………………..1
  1.2 Background to the Study…………………………………………………………………………3
  1.2.1 Definition of Mobile Learning ………………………………………………………………..3
  1.2.2 Why Mobile Learning? ………………………………………………………………………..5
  1.2.3 Learning Activities outside the Classroom…………………………………………………8
  1.3 Research Questions and Potential Contributions…………………………………………..11
  1.4 Outline of the Thesis ………………………………………………………………………………13

Chapter 2: Literature Review ……………………………………………………………………………15
  2.1 M-learning vs. E-learning ………………………………………………………………………….16
  2.2 Mobility as a Key Concern ………………………………………………………………………..22
  2.3 Mobile Learning implies Learning Activities outside the Classroom ……………………24
  2.4 Summary of Literature and Implications of Studies …………………………………………30

Chapter 3: Methodology …………………………………………………………………………………31
  3.1 The Experiments ………………………………………………………………………………….31
  3.2 Apparatus …………………………………………………………………………………………34
6.4 Future Work ........................................................................................................... 71

References

Appendix A: Screenshots of E-learning Tool......................................................... I

Appendix B: Screenshots of “Learning beyond Classroom” Applications........ III

Review ....................................................................................................................... III

Preview ..................................................................................................................... VII

Appendix C: Source Codes of “Learning beyond Classroom” Applications ..... XI

Review ..................................................................................................................... XI

Preview .................................................................................................................... XVIII

Appendix D: Questionnaires ................................................................................... XXIII

Experiment 1: Questionnaires (E-learning vs. Mobile Learning)............. XXIII

Experiment 2: Questionnaires (In classroom vs. Beyond classroom) .... XXIV

Experiment 3&4: Questionnaires (Different Time) ....................................... XXV
LIST OF FIGURES

Figure 1.1 Suchart Kittanasearee's m-learning course ................................................... 7
Figure 1.2 My Sports Pulse.................................................................................................. 7
Figure 2.1 Screenshot of "Mobile Game"........................................................................ 26
Figure 2.2 Scene of "One Day Trip with PDA".............................................................. 27
Figure 2.3 Example pages from Thornton and Houser's research................................. 29
Figure 3.1 Nokia 7610 (© Jørgen Sundgot)................................................................... 34
Figure 3.2 Screenshot of mobile applications sent by e-mail ....................................... 35
Figure 4.1 Ease to learn ............................................................................................... 46
Figure 4.2 Simple usage ............................................................................................... 47
Figure 4.3 Convenience ............................................................................................... 48
Figure 4.4 Utility .......................................................................................................... 49
Figure 4.5 Attitude to use ............................................................................................. 50
Figure 4.6 Suitability ................................................................................................... 53
Figure 4.7 Convenience ............................................................................................... 54
Figure 4.8 Attitude to use ............................................................................................. 55
Figure 5.2 Comparison between m-learning and e-learning ........................................ 62
Figure 5.3 The result of Experiment 2 ......................................................................... 64
Figure 5.4 Additional analysis to compare review vs. preview ................................... 65
LIST OF TABLES

Table 1.1 Current learning activities (In/ Beyond classroom learning) ......................... 9
Table 2.1 Comparison of e-learning and m-learning (Sharma and Kitchens, 2004; Nash, 2007) .................................................................................................................. 19
Table 3.1 The number of participants for each experiment ........................................... 38
Table 3.2 Experimental design of the first experiment ............................................... 39
Table 3.3 Experimental design of the second experiment ......................................... 39
Table 3.4 Experimental design of Experiment 3 ......................................................... 40
Table 3.5 Experimental design of Experiment 4 ......................................................... 40
Table 3.6 Details of experiment design ...................................................................... 41
Table 4.1 E-learning vs. m-learning ........................................................................... 45
Table 4.2 In the classroom vs. out of the classroom ..................................................... 52
Table 4.3 Review-based learning at different times ...................................................... 56
Table 4.4 Preview-based learning at different times ....................................................... 58
Table 4.5 Review-based learning vs. preview-based learning ....................................... 59
Table 5.1 Summary table of research questions and answers .................................. 61
STATEMENT OF ACADEMIC INTEGRITY

I declare that this research study is entirely the product of my own work and that it has not been taken from the work of others. When the work and ideas of others has been used in the study, the work has been properly cited in the text.

__________________________

Lei (Pluto) Wang
I owe a great deal of gratitude to people who, in various ways, helped to make this project possible. Particularly, I would like to thank my supervisor Dr Hokyoung Ryu for providing me with this opportunity. Thank you for your guidance, your revisions and patience with my questions in stressful times. I would also like to mention my family and my dear friends and flatmates (SuyiGuo, Liye Zhang and Ting Yue) for providing me with support whenever I need it and brightening up my year.
Chapter 1: Introduction and Background

1.1 Introduction to the Study

Providing learners with effective learning experiences is always one of the key concerns in the modern pedagogy. New educational technologies (e.g., online learning or distance learning) have been proposed to meet this ever-achieving objective and now mobile learning appears to be alternatively considered as a promising way of supporting many educational activities, given the high mobile device penetration and the high level of mobile phone usage within the potential target audience, i.e., the younger generation (specifically, the Y generation).

Arguably, mobile learning is obviously seen as a new generation of learning paradigm which follows the traditional lecture-based learning and the complimentary e-learning pedagogy (Ryu and Parsons, 2008). Traditional lecture-based education methods rely heavily on both printed materials (e.g., textbooks, teaching slides and so forth) and face-to-face interaction in the classroom (e.g., lectures, tutorials and laboratory work). It is widely said that this form of learning activities has significantly restricted learners’ mobility. Additionally, it can be said that this form of education has a lack of learner engagement and motivation because it comes at the price of making interaction between learners and lecturers harder and inefficient (Collis, 1996; Freeman and Blayney, 2005; Harasim et al., 1995; Mason, 1998; Sorensen and Takle, 2002; Traxler, 2005). Instead, to a greater extent, e-learning has overcome these limitations of the traditional lecture-based learning activities, and highly applicable to other learning activities such as life-long learning (Sharples, 2005). However, people have now grown to expect more connectivity as a key factor of future learning activities,
thanks to the mobile penetration (Ryu and Parsons, 2008). Handheld devices have the potential to effectively control "push" and "pull" information and deliver learning content whenever and wherever the learners' needs arise. Many researchers or educators have recognised that mobile technology for learning has the certain merits (Brown and Metcalf, 2008).

As mobile technologies have been widely welcomed in relation to the nature of modern learning activities, some researchers have gone as far as to say outlined mobile learning might be superior when learning goes out of the classroom, e.g., children’s field trips, language learning without having formal classes or children’s literacy programmes and so forth (Keegan, 2002; Scanlon and Issroff, 2005). Behind this sense of understanding is a consideration of the amount of time for students to spend outside the classroom and an attentive learning support for them during this dubious time. Especially for university students, beyond classroom learning activities, such as a review or preview of the course, play important parts in their learning experiences. However, there are currently minimal studies in this research area, which is the central research topic of this thesis.

This study focuses on developing a text-based mobile learning application (i.e., review or preview course content), benefitting university students by allowing them to take their learning activities on their own mobile handset beyond the classroom environment. Several experiments were designed to figure out the potential acceptance of this mobile learning tool and the issues related to the ‘beyond classroom’ mobile learning experience. Further, we explored the main benefits of mobile learning, comparing it with e-learning and thus to say if users can conceive mobility as one of the key factors in their learning activities at the University campus.
1.2 Background to the Study

1.2.1 Definition of Mobile Learning

Mobile learning is not a new concept; its definition is still evolving along with the advent of new technologies. Briefly, around a decade ago, Quinn (2000) described mobile learning as learning activities which take place with the assistance of mobile devices. In a similar vein, Traxler (2005) also defined mobile learning in a techno-centric way; from his perspective, similar to Quinn's (2000), any education where the sole technologies are handheld or palmtop devices can be considered as mobile learning.

Contrary to the technology-oriented definition above, several researchers have emphasised mobile learning as a pervasive learning experience which can rearrange people’s work, study and leisure time in meaningful ways (Turunen et al., 2003). Likewise, Shaples (2005) claimed mobile learning has a very non-replaceable role that can enhance communication and conversation between the education consumer and producer. Polsani (2003) also argued the hardware-oriented definitions seem too restrictive, viewing mobile learning as a new form of education — whose site of production, circulation, and consumption is the network”, a.k.a., networked learning'. A tentative definition of mobile learning now widely accepted in this research community, was proposed by Sharples et al. (2007), that mobile learning is the processes of coming to know through conversations across multiple contexts amongst people and personal interactive technologies.”

As one can see the brief discussion from above, it is not quite easy to define what mobile learning is, but the following summaries will help readers to understand what
objectives mobile learning is currently serving (Winters, 2006):

**Definition 1: Techno-centric view**

Simply put, mobile learning is learning with mobile devices. One of the major debates of this definition is whether or not to embrace laptop computers (with or without e-learning through these computers). For example, Quinn (2000) did not include them in his definition; in contrast, both Traxler (2005) and Sharples *et al.* (2002) considered them.

**Definition 2: Part of e-learning – Blended learning**

The definitions related to this perspective often include traditional e-learning systems, characterising the unique nature of mobile learning as blended learning experiences with e-learning on mobile devices. For instance, Traxler (2005) defined mobile learning as “somewhere on e-learning’s spectrum of portability”.

**Definition 3: Mobility**

In this perspective, the focus is on the mobility of the learner, which has not been considered in any other computer-mediated learning activities. For example, in lifelong learning, ongoing learning activities result from the integration of formal and informal education, creating personal capability for continuous lifelong development of quality of life, and so forth (Kruse, 2003). Here, people rarely take their learning activities in a particular place such as a classroom, or arrange some formal learning time such as a lecture, so mobility-based learning may fulfill their needs to learn anytime anywhere they
want. Sharples et al. (2002)’s definition applies to this perspective.

1.2.2 Why Mobile Learning?

The previous section presented diverse definitions of mobile learning encompassing the techno-centric to user mobility standpoint. In this section, we explore why modern pedagogy has been attracted to mobile learning in three main aspects.

Firstly, many say that the new Y generation, i.e., the “Mobile Generation” pushed modern education towards the mobile trend. The innovation and popularisation of mobile devices and technologies have permeated society to such an extent and the perception of mobile phones is not just as telecommunication tools, but also key digitalised information assistants in people’s pockets (Wagner, 2005). For them, mobile propensity remains attached to their mobile and nomadic lifestyles that shape their modern hectic lifestyles, work, play and also learning (Lasica, 2007). Most university students are especially “addicted” mobile users and have even been dubbed “mobile addicts”. Oblinger (2004) considers the key traits of these university students as being (i) digital literate, (ii) always on, and (iii) mobile and community oriented. “Digital literate” refers to people who are very confident in their use of information technologies which are critical for work, leisure and communication. People with these traits are able to frequently use mobile devices to retrieve, access, store, produce, present and exchange information, and to communicate and participate in collaborative networks via mobile technologies (Rychen and Salganik, 2003; Gapski, 2007). The second trait “always on” refers to the fact that many students in the tertiary education sector tend to be always communicating with friends, peers and instructors constantly, through a range of digital devices and technologies such as mobile phones,
instant messaging (IM) or e-mail (Gapski, 2007). Hence, for them, the third trait ‘mobile and community oriented’ indicates that such students prefer to learn by doing, as opposed to learning just by listening to an instructor or reading from materials. Here, contributing to the learning community (e.g., with friends or peers) is important in their learning activities.

Secondly, the development of mobile technologies and services would seem to support the uptake of mobile learning in the near future. Recently, mobile phones have become more and more sophisticated with wide implementation of incoming mobile technologies and services such as Bluetooth, WAP (Wireless Application Protocol), GPRS (General Packet Radio System) and UMTS (Universal Mobile Telecommunications System). That is, the small devices have been no longer just a talking machine, having turned them into personal assistant tools (Lu, 2007; Keegan, 2002; Sharples, 2000). These mobile technologies and services consequently enable feasible mobile learning more than ever before. For example, in Thailand, ‘Kittanasearee’ (Brown, 2007) allowed students to access lessons anywhere by porting all courses to their own mobile handset using their GPRS network, as shown in Figure 1.1. SMS (Short Message Service) and IVR (Interactive Voice Response) was also applied in a joint endeavour between the University of Central Florida (UCF) and the Ewing Marion Kauffman Foundation – called ‘My Sports Pulse’, as shown in Figure 1.2 (Brown, 2008).
Figure 1.1 Suchart Kittanaseeree’s m-learning course

Figure 1.2 My Sports Pulse
Finally, mobile learning certainly offers the mobility benefit. Thanks to that, the Y generation of learners is very much expecting learning to be done via mobile. Unlike primary and secondary school students, university learners are not always in the classroom, so the mobility issue is obviously more important. The university learners require efficient learning supports to avail their learning activities anytime and anywhere. Hence, mobile phones as ‘always on’ personal assistant devices might offer university learners a convenient approach to accessing learning materials and so carry out their learning activities without time or location limitations. Also this can facilitate instant and spontaneous communication and collaboration between learners and educator, or learner and learner (Wagner, 2005).

By and large, the three reasons above briefly explain why modern pedagogy has invited mobile learning in its pedagogical sphere. Though there would be many other reasons to take account of it, one thing for sure is that the university learners and mobile technologies are both ready to allow mobile learning in practice, and in particular, the mobility benefits may attract the new generation's attention and fulfill their needs.

1.2.3 Learning Activities outside the Classroom

Having said that the new Y generation would like to get into mobile learning, a key question is how to apply mobile learning to their learning activity design outside the classroom. Although classroom learning activities are still central to formal education, outside classroom learning activities can also play an important role, particularly for the tertiary education sectors (Solomon, 2002).

Table 1.1 depicts almost all the common learning activities at the university level.
As it indicates, beyond classroom learning activities include those such as previews of upcoming lectures, reviews of past lectures, assessment of courses, pop-quizzes, report writing and related material reading.

Table 1.1 Current learning activities (In/ Beyond classroom learning)

<table>
<thead>
<tr>
<th>Learning Activities</th>
<th>In Classroom Learning/ Beyond Classroom Learning Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview of the upcoming lectures</td>
<td>Beyond</td>
</tr>
<tr>
<td>Lecture</td>
<td>In</td>
</tr>
<tr>
<td>Review of the past lectures</td>
<td>Beyond</td>
</tr>
<tr>
<td>Assessment</td>
<td>Beyond</td>
</tr>
<tr>
<td>Pop quizzes</td>
<td>Beyond</td>
</tr>
<tr>
<td>Report writing</td>
<td>Beyond</td>
</tr>
<tr>
<td>Experiment</td>
<td>In</td>
</tr>
<tr>
<td>Related material reading</td>
<td>Beyond</td>
</tr>
<tr>
<td>Exam</td>
<td>In</td>
</tr>
</tbody>
</table>

The main interests in this thesis are the three ‘beyond classroom learning activities’ from the table above: ‘Preview of upcoming lectures’, ‘Review of the past lectures’, and ‘Pop-quizzes’. Preview of the upcoming lectures and review of past lectures are necessary and important ‘beyond classroom learning’ activities at university.

Previews of upcoming lectures may help students to make connections between the learning material from a previous class and the upcoming class, encouraging students to pay attention during lectures (The Augustine Club, 1996). Reviews of past lectures would also help students to digest and consolidate from previous lectures, assisting what they have learnt to become knowledge retained in their memory for a long time (Keelay, 1997). Quizzes, as the most effective form of review of past lectures, are frequently employed at university. They offer an essential link between...
the assessment of learning outcomes and the related resources given during lectures. A lecturer's perspective involves figuring out how to improve the learning effect; and from a learner's perspective, quizzes can encourage learner's motivation and engagement, assisting them to identify their learning requirements (QIA Excellence Gateway, 2008). Note that this quiz experience is currently implemented either in lecture time or through e-learning systems. One can see the benefit of mobile learning if, and only if, the quiz-based learning experience is well embedded in mobile learning. Hence, this thesis aims to investigate empirically the effect of applying mobile technologies to learning activities with quizzes (for review of past lectures and preview of upcoming lectures).
1.3 Research Questions and Potential Contributions

The purpose of this study is to explore a series of text-based m-learning applications called “Learning beyond Classroom” to address the feasibility of this form of mobile learning activities for university courses. Specifically, this thesis is based on the following research questions:

Point 1: Would people accept these quiz-form mobile learning applications? If so, how would they like to use it?

The acceptance of mobile learning includes (i) whether users can easily learn to use mobile learning applications; (ii) the functionality of the mobile learning applications can undertake the requirements of learning activities; and (iii) whether users can perceive them as convenient and efficient while applying mobile learning.

Point 2: What benefits would be represented by this “beyond classroom” mobile learning activity, compared with e-learning?

E-learning is always considered the important barometer of mobile learning. For this reason, comparison of mobile learning with e-learning will easily locate the pros and cons of mobile learning. These benefits, if any, should be the key points to attract learners to choose mobile learning tools to support their learning activities.

Point 3: Whether users can also achieve learning outcomes through m-learning?

The mobility issue is the core part of mobile learning; however it has not been
thoroughly studied whether or not mobility can aroused the learning enthusiasm of the learners, or enhance learners' learning activities. People may expect to do their outside-classroom learning activities without time and location limitations, but achieve the same learning outcomes.
1.4 Outline of the Thesis

Chapter Two further provides a review of the literature pertinent to the research topics raised in this introduction. It focuses primarily on literature published in the mobile learning and education technology research community. In particular, the review seeks to show potential benefits of mobile learning compared with e-learning, in some areas. Chapter Three describes an overview of the methodology employed in this thesis. Also, it offers the proposed design of the ‘Learning beyond Classroom’ application. In Chapter Four, data analyses are made, and the next chapter discusses the key findings. Finally, Chapter Six provides the recommendations for future research. The implications are also highlighted and the limitations of this research are presented.
Chapter 2: Literature Review

In the previous chapter, we located two major issues to be explored in this thesis: (i) the comparisons between m-learning and e-learning (hence to sketch out the key reasons for learning in mobile way), (ii) the mobility issue and its ripple effects on the design of mobile learning applications, i.e., the ‘beyond classroom’ application. This chapter further discusses these topics.

We first note that the comparison between m-learning and e-learning may represent the reason why people have a strong inclination toward mobile learning while they have been adopting e-learning. Despite many researchers having defined mobile learning as part of e-learning (Traxler, 2005), there have also been identified several differences between mobile learning and e-learning. Some of the differences include the challenges or barriers of mobile learning; others include the benefits of mobile learning which can attract people to do their learning activities in a mobile way. It is widely believed that the mobility factor is the most attractive feature of mobile learning (Wagner, 2005). In this sense, to be fair, we would like to discuss the mobility issue of mobile learning and why it should be a key concern in a student's learning experience. Modern learning activities (specifically, life-long learning or tertiary learning) have been described using the term ‘nomadic’, which means learners' life space is dramatically enlarged and they intend to take their learning on the move (Reynard, 2008; Sharples et al., 2007). As a consequence, people are expected to carry out their learning activities using mobile devices (Alexander, 2004). This understanding, of course, leads us to focus on appropriate mobile learning applications that purport these nomadic learning activities outside the classroom, and
how they ultimately make a difference in the learning experience.

With these two research questions in mind, the following sections further describe each of the research questions, aligning them with relevant literature from the mobile learning research community.

2.1 M-learning vs. E-learning

More often than not, e-learning is considered as a criterion of a successful mobile learning project. For example, Chan and his colleagues (2001) compared mobile learning used for outside and inside classrooms with a Web-based learning system, called EduCities, finding that mobile learning could enable life-long learning with the benefit of private and social enrichment (Chan et al., 2001). Contrasting e-learning and m-learning, they identified that well designed and organised mobile learning activities might take advantage of frequently changing instructional contexts or environments to allow the learner to link content without time and location limitations (Nash, 2007).

Indeed, much literature has pinpointed distinctive descriptive words for e-learning and m-learning, for which one can easily see their differences. E-learning is commonly referred as as “multimedia, interactive, hyperlinked, and media-rich”; on the other hand, mobile learning is “spontaneous, intimate, situated, connected, informal, lightweight, and personal” (Laouris and Eteokleous, 2005). Of course, m-learning also can be interactive and hyperlinked as is e-learning, but its original objective heavily rests on the Laouris and Eteokleous’ definition.

To allow mobile learning to be spontaneous and situated, mobile learning is
using portable devices (e.g., mobile phones, laptop computers and or handheld devices). In contrast, e-learning refers to learning wherein computers are primarily used to enable learning between the learners, the teacher, and/or peers. It usually takes advantage of adopting the Internet, or LAN (Local Area Network) and WAN (Wide Area Network), for delivery of the information required to facilitate their learning, and the interaction and facilitation of the entire learning session are only through computers (Muir, 2006). M-learning, by contrast, mobile devices such as mobile phones or PDAs (Personal Digital Assistants) are used for learning activities (Rosman, 2008), which implies learning mobilities (Sharma and Kitchens, 2004).

Another significant difference between e-learning and m-learning can be found in the media being employed. Quite often e-learning has the advantage of being "media-rich" since all sorts of media (e.g., video, audio, animation and so forth) can be accessed easily with the help of various computer programs and a higher bandwidth of the network. For instance, some videos and images that only run on specific software can be easily accessed (Nash, 2007). By contrast, m-learning cannot use such various forms of media due to the limited computing power and the diverse system specifications. Having said that, m-learning requires data that must be run even without the use of complicated software programs since mobile devices are not created to handle data that ask large computation or memory storage (Sharma and Kitchens, 2004; Nash, 2007).

In our age, Internet is the biggest information network in the world, providing facilities such as e-mail, file transfer protocol (FTP), workgroups discussion or chat. E-learning exploits World Wide Web (WWW) through the Internet, allowing a major impact on "distance learning". It is usually defined as a learning process during which
the learner and faculty member are separated by space, time or both (Florida Distance Learning Consortium, 2008). For instance, a number of online tutorial centers have sprouted up all over the globe, where individuals can learn from tutors based in other countries. Yet, the success of distance learning is not the exact case of mobile learning. M-learning, on the other hand, has been aimed not only to gain information from a community, but also to share information with a community. For instance, people who are on the go can take pictures of their surroundings or the location they are currently at, and share this information with a wider community. It means that mobile learning can be more than just the distance learning that e-learning has purported. Hence, it is important that the promptness of mobile learning should be noted. E-learning appears to have a time delay when it comes to the information relayed from the instructor to the student. In this light, the majority of e-learning methods that are implemented in education systems involve the student's responsibility to regularly check his/her e-mail or to log on to specific websites to gain access to necessary information. This makes e-learning somewhat ‘asynchronous’ since information is not always received at the same time as it is delivered especially when users can not access computer or internet. In contrast, m-learning is ‘synchronous’ since the student can gain information whenever it is needed from the mobile device (Sharples, 2006).

Thanks to the limited computing power of mobile handsets, the content design for mobile learning should also be different. The content of e-learning is often the webpages. With the help of the Internet, there are large numbers of libraries and repositories to be found with the related learning materials, even various media for learning activities. In contrast, the content for mobile learning needs to consider the device features and the ‘mobility’ issue of mobile learning. The contents, therefore,
need to be ruggedised to fulfill the requirement of portable and interactive mobile devices. The learning material also needs to be designed to be easily acceptable while moving around without any extra cognitive workload (Nash, 2007).

Besides the differences described above, many researchers offered rather different characteristics of m-learning and e-learning. Table 2.1 summarises the comparisons – mostly from both Sharma and Kitchens (2004) and Nash (2007). Although this table is very comprehensive, it still cannot cover all the differences between m-learning and e-learning. However, it is the author's personal belief that this is sufficient to see the key differences between e-learning and m-learning, and to poise m-learning on whole learning activities.

Table 2.1 Comparison of e-learning and m-learning (Sharma and Kitchens, 2004; Nash, 2007)

<table>
<thead>
<tr>
<th>Comparison issues</th>
<th>E-learning</th>
<th>M-learning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device Adoption</strong></td>
<td>Computer</td>
<td>Mobile</td>
</tr>
<tr>
<td></td>
<td>Enough memory</td>
<td>Limited memory</td>
</tr>
<tr>
<td></td>
<td>Large screen</td>
<td>Small screen</td>
</tr>
<tr>
<td><strong>Terminology Comparisons</strong></td>
<td>Wired bandwidth</td>
<td>Wireless bandwidth such as GPRS, G3, Bluetooth</td>
</tr>
<tr>
<td></td>
<td>Collaborative</td>
<td>Networked</td>
</tr>
<tr>
<td></td>
<td>Media-rich</td>
<td>Lightweight</td>
</tr>
<tr>
<td></td>
<td>Distance learning</td>
<td>Situation learning</td>
</tr>
<tr>
<td></td>
<td>Simulated situation</td>
<td>Realistic situation</td>
</tr>
<tr>
<td><strong>Pedagogical Challenges</strong></td>
<td>More text- and graphics based</td>
<td>More voice, graphics and animation</td>
</tr>
<tr>
<td></td>
<td>Lecture in classroom or in internet labs</td>
<td>Learning occurring in the field or while mobile</td>
</tr>
<tr>
<td><strong>Instructor to Student Communication</strong></td>
<td>Time-delayed (students need to check e-mail or</td>
<td>Instant delivery of e-mail or SMS</td>
</tr>
<tr>
<td>Student to Student Communication</td>
<td>websites)</td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td>Passive communication</td>
<td>Instant communication</td>
<td></td>
</tr>
<tr>
<td>Asynchronous</td>
<td>Synchronous</td>
<td></td>
</tr>
<tr>
<td>Scheduled</td>
<td>Spontaneous</td>
<td></td>
</tr>
<tr>
<td>Audio-teleconference common</td>
<td>Audio-video-teleconference possible</td>
<td></td>
</tr>
<tr>
<td>e-mail-to-e-mail</td>
<td>24/7 instantaneous</td>
<td></td>
</tr>
<tr>
<td>Private location (With access to computers or internet)</td>
<td>No geographic boundaries</td>
<td></td>
</tr>
<tr>
<td>Travel time to reach to internet site</td>
<td>No travel time since wireless connectivity</td>
<td></td>
</tr>
<tr>
<td>Dedicated time for group meetings</td>
<td>Flexible timings on 24/7 basis</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Feedback to Students</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1-to-1 basis possible</td>
<td>1-to-1 basis possible</td>
</tr>
<tr>
<td>Asynchronous and at times delayed</td>
<td>Both asynchronous and synchronous</td>
</tr>
<tr>
<td>Mass/standardized instruction</td>
<td>Customized instruction</td>
</tr>
<tr>
<td>Benchmark-based grading</td>
<td>Performance &amp; improvement-based grading</td>
</tr>
<tr>
<td>Simulations &amp; lab-based experiments</td>
<td>Real-life cases and on the site experiments</td>
</tr>
<tr>
<td>Paper based</td>
<td>Less paper, less printing, lower cost</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Content attributes</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready access</td>
<td>Portable, interactive</td>
</tr>
<tr>
<td>Vast libraries and repositories</td>
<td>Limited media</td>
</tr>
<tr>
<td>Immersion multimedia</td>
<td>Gather data</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Outcome attributes</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Skillful making interdisciplinary connections</td>
<td>Situated problem-solving</td>
</tr>
<tr>
<td>Trace history of ideas &amp; evolution of thought</td>
<td>Able to integrate multiple content source</td>
</tr>
<tr>
<td>Apply theory to primary texts</td>
<td>Create “map”</td>
</tr>
<tr>
<td></td>
<td>Develop tangible “solution” as outcome</td>
</tr>
</tbody>
</table>

In effect, mobile learning may be considered as the extension or evolution of e-learning, which adds missing components of the solution (e.g. the mobile feature)
(Sharples, 2005; Geogiew et al., 2004). Also, the comparisons discussed above represent how to design and apply mobile learning in an appropriate way. According to this, some differences such as limited memory or the small screen need to be paid much attention to avoid poor performance of mobile learning. Other differences, especially the mobility issue, may be the key attractions of mobile learning and this is explored in the following section (Chris and David, 2002; Sharples, 2006; Uden, 2007).
In Chapter 1, we claimed that mobility could be the central concern of any mobile learning. Indeed, mobility refers to the ability to move freely from location to location, and mobile learning is particularly created with the thought in mind that people do not stay at one place all the time. Hence, the learning process in mobile learning would be ‘nomadic’ (e.g., learning can happen at workplace, at home or at places of leisure with mobile learning (Vavoula and Sharples, 2002)), by which they do not need to stay in a classroom or adhere to the conventional learning styles that classroom-based learning activities imply. In addition, mobility indicates that learning can be mobile with respect to time (Vavoula and Sharples, 2002). With mobile learning, people do not need to schedule formal time for learning and are free to utilise any time (e.g., tea break during they are working or travelling time while on the train or bus) they prefer to do some learning activities.

In effect, the benefits of the mobility in mobile learning can be thus categorised into three factors (Oblinger, 2006): ‘Choice’, ‘Control’ and ‘Embedded’. When it comes to ‘choice’, the students can optimise their daily life with learning activities through mobile learning. This would be especially useful for students who live away from the educational institution. With mobile learning, they do not need to sacrifice other time such as work to attend lectures; or waste time accessing formal education institutions. An example of this factor would be Kittanasearee’s m-learning course mentioned in the previous section 1.2.2, which offered learners access to lessons without actually going to the school (Brown, 2007). Freedom of learning choices in mobile learning inevitably results in free ‘control’ of their learning activities, where self-regulation is significantly important (Oblinger, 2006; Dantec and Jowers, 2007;
Naismith et al., 2004). Learners can control their learning activities without other controls of instructors or someone else. They can choose their own learning directions, discover their own learning resources, and formulate their own learning schedules. Mobile learning encourages the motivation and engagement of learners, because they feel they are in control of their learning activities. For example, MOBIlearn (http://www.mobilearn.org) is a European-led research and development project using mobile technologies to explore context-sensitive methods for mobile learning. One of their missions is to develop mobile learning products and services to attract the unemployed or homeless young generation without formal education. With the assistance of mobile learning tools, learners can control their learning by themselves to improve their literacy and mathematics (Ting, 2005). Following on from the factors discussed above, mobile learning can be easily embedded into people’s everyday life. Even very smaller time intervals and any location can be well utilised to do some learning activities. For instance, while waiting for the bus students may carry out mobile learning activities or lining up for tickets (Oblinger, 2006). Several studies examine this factor further. For example, the Swedish International Development Agency offered African people information about HIV/ AIDS through mobile devices without formal education, especially for the mobile population (Glanz, 2007). In Australia, Adelaide Zoo explored a mobile learning trial to provide students with information about pandas (Flexenews, 2008), in order to give an embedded learning experience while they are roaming in the zoo.

By and large, it seems that the concept of mobility is thought to be closely linked to the nature of mobile learning and modern education requirements (Naismith et al., 2004).
2.3 Mobile Learning implies Learning Activities outside the Classroom

Beyond classroom learning activities, unlike the lecture-based learning activities, allows ones to proceed with learning activities at their own pace and place (Csete et al., 2004). In particular, there is strong evidence that successful learning outside the classroom gains a greater value compared to classroom learning (Learning Outside the Classroom, 2006).

Indeed, despite classroom-based learning activities still being the core of any academic education, work outside the classroom is said to give another in-depth understanding of the curriculum and make an important contribution to students’ physical, personal and social education (Ofsted, 2004).

In this sense, education practitioners and researchers have paid much attention to applying mobile learning to design appropriate learning activity outside the classroom. For instance, the Learning Skills Development Agency (LSDA) in the U.K found out that a group of users (216 juvenile offenders) have been significantly motivated by mobile learning, and actually preferred it to traditional in-classroom learning. Interestingly, this group of users has significantly improved their social skills which were not possible by any other educational measures for them (Livingstone et al., 2006).

By comparison, Schwabe and his colleagues (Roschelle et al., 2005; Schwabe and Goth, 2005) viewed a mixed reality in which physical space is augmented with contextual information on the mobile device, as the way forward in mobile learning. In this study, they designed a prototype of mobile learning —“Mobile Game”, exploring the opportunities to support learning through an orientation game in a university
setting. In the orientation rally, new students were separated into several groups. The orientation rally was structured as a cooperative and competitive game. Each group was assigned into different tasks which provided them with basic information about university life, such as finding important places (e.g. the library, the cafeteria or the laboratories); then performing relevant tasks (find a book, have drinks, etc.); and then they needed to answer some simple questions displayed on the PDAs, such as “what is the price of an apple pie?” Unless the group members gave the correct answers to these questions, they were not allowed to move to the next task. The tasks were executed with the support of the “Mobile Game” application (e.g. providing with related information), as shown in Figure 2.1. The study showed students engagement and motivation from these outside classroom learning activities to be increased by applying the location-aware mobile learning applications.
Ogata et al. (2006) also developed a “non-classroom” based language-learning support system for overseas students in Japan —*One Day Trip with PDA*”. This system was to assist overseas students of Tokushima University to learn Japanese while involved in their daily life situation, using the PDAs. With the LOCH (Language-learning Outside the Classroom with Handhelds) system, the instructors assigned field activities to the students to go around the town; so they could learn Japanese through their own individual experiences. The students interacted with native Japanese speakers with the assistance of teachers through LOCH. The scenes of
the study were depicted in Figure 2.2. This study empirically confirmed that mobile learning activities could be effectively embedded into learners' daily life.

Figure 2.2 Scene of "One Day Trip with PDA"
Roschelle et al. (2005), and Thornton and Houser (2005), on the other hand, linked informal, asynchronous and casual mobile learning activity with formal classroom instructions. They created a series of web pages which could be viewed by mobile phones for Japanese students to learn English idioms. Each web page presents one idiom (e.g., _He has a big mouth._). First, it explains the idiom’s meaning in the students’ first-language which is Japanese in this case. Then it offers a computer animation illustrating the literal meaning (e.g., a character with an unusually large mouth), and presents an English script and live-action video. The video shows what the idiomatic meaning in a real situation (e.g., a person who talks too much, giving away secrets). At the end, a final quiz checks students’ understanding. Figure 2.3 includes some screenshots of the mobile learning application. The experimental result showed the mobile learning application significantly improved students’ learning, and outlined a successful way to intensify their existing learning activities (Roschelle, 2005; Thornton and Houser, 2005).
Figure 2.3 Example pages from Thornton and Houser’s research
2.4 Summary of Literature and Implications of Studies

This chapter discussed the comparison between e-learning and m-learning; explored the mobility concept of mobile learning; and represented several previous studies about mobile learning activities outside the classroom. Building upon this literature review, this thesis focused on the three research questions which include the acceptance of such mobile learning activities outside the classroom; what benefits would be represented by this mobile learning activities compared with e-learning; whether users can achieve similar learning outcomes with mobile learning, which has been little investigated. To empirically find out answers to these questions, several experiments are designed and the next chapter will discuss how the experiments are designed and what methods are used for the experiments to empirically examine the research questions in this thesis.
Chapter 3: Methodology

This chapter describes the experimental settings and procedures of the empirical studies carried out in this thesis. In particular, section 3.1 gives the purposes of a series of experiments to examine the effectiveness of mobile learning applications. Section 3.2 describes the apparatus employed in the experiments. Section 3.3 describes the method and procedure of the experiments. Finally, section 3.4 describes how the data was collected and analysed.

3.1 The Experiments

The first experiment was to compare a review-based mobile learning application against traditional e-learning systems. To empirically demonstrate this, participants attempted “How to use Microsoft Word to produce documents” courses through both e-learning (Condition A) and mobile learning (Condition B). As discussed in Chapter 2, review of the past lecture is one of the important learning activities which would help students digest and consolidate the learning content they had studied from a previous lecture, assisting what they had learnt to become the knowledge in their memory for a long time (Keelay, 1997). In this study, we employed the online quizzes from the Microsoft Office online support website (refer to http://office.microsoft.com/en-us/help/FX100485331033.aspx). This website offers multiple-choice questions about how to use Microsoft Office. As shown in Appendix A, the learning application presents quizzes about how to use Microsoft Office. Participants answered the questions and the subsequent page – "Result & Comment Page" (as also shown in Appendix A), provided the correct answers with related comments and explanations. In this experiment, as a contrasting system, a mobile
‘Review’ application was considered – the only difference being that it was administered by mobile phones supplied or their own mobile phones. The details of the mobile ‘Review’ application can be found in Appendix B. Note that the mobile learning application had exactly the same questions and results as those of the Web-based e-learning system.

The second experiment was designed to compare the performance of mobile learning ‘in’ and ‘out’ of the classroom. Most of the learning activities can be done in the classroom, but mobile learning could also be employed out of the classroom. To empirically demonstrate this, our participants attempted to review the ‘How to use Microsoft Word to produce documents’ course in a classroom (Condition A) and out of the classroom (Condition B). That is, after a lecture, in the case of Condition A, all the participants were required to carry out a review of the course in the classroom within an hour. In contrast, Condition B allowed the participants to go out of the classroom (i.e., wherever they wanted to be) to do this within an hour. This experimental setting was expected to show whether mobility that mobile learning underlies would make a difference in learning experiences. In this experiment, we employed the same ‘Review’ application as Experiment 1, but with different question sets.

Finally, building upon Experiment 2, both the third and fourth experiments were intended to measure the effectiveness of mobile learning applications in terms of the time of learning activities – preview or review. While both preview and review learning activities are necessary and important ‘out of the classroom’ learning activities in the university, we hypothesised that ‘preview’ would be improved using mobile learning, because this might significantly facilitate the preparation of future
learning activities (The Augustine Club, 1996). If this hypothesis is confirmed by these two experiments, one can easily foster the effectiveness of mobile learning applications. To see the differences between _preview_ and _review_, Experiment 3 explored the learning activities with _review_; and Experiment 4 with _preview_. In Experiment 3 (i.e., review-based learning), we compared the performance of a mobile learning application just after a lecture (Trial 1) and just before the next lecture time (Trial 2). In a similar vein, Experiment 4 (i.e., preview-based learning) compared the learning performance just after a lecture (Trial 1) and just before the next lecture time (Trial 2). Having set up these experiments in this way, one can see when mobile learning would best serve each of learning activities and/or whether it would motivate the learner’s attitude or preparation in their self-managed learning activities.
3.2 Apparatus

The mobile learning applications used in this study were implemented with JAVA™. The source codes for these programs are presented in Appendix C. The lecturer sent them through Bluetooth™ or via e-mail to the participants, which enabled them to download the applications to their own mobile device or the mobile phone given.

3.2.1 Hardware Issues

In all the experiments, several mobile phones were employed to run the mobile learning applications. The applications were sent to the participants in two ways: Bluetooth or E-mail. These will be discussed later.

The mobile phones employed in these experiments were Nokia™ 7610 as shown in Figure 3.1. It is a Smartphone with 65 K colour and 176 x 208 pixels screen. At their convenience, the participants were able to use their own mobile phone to run the mobile application, in cases where they had Java-enabled phones.

Figure 3.1 Nokia 7610 (© JørgenSundgot)
An Asus™ F8sv notebook was employed to send the mobile learning application by Bluetooth. Either way, the participants were sent an e-mail including the application, as shown in Figure 3.2.

![Screenshot of mobile applications sent by e-mail](image)

**Figure 3.2 Screenshot of mobile applications sent by e-mail**

We collected the performance of the participants after the experiment, downloading their scores and answers for each question from either their own mobile phones or the phone given to them.

### 3.2.2 E-learning system

As referred to in section 3.1, the e-learning system was considered as a control group in Experiment 1 (see Appendix A for its details). E-learning is always deemed as an important barometer of mobile learning. For this reason, a comparison between m-learning and e-learning may show why people have a strong inclination toward mobile learning while they have already adopted e-learning (or the other way around).

The students who enrolled in the course —How to use Microsoft Word to produce documents” of —Business Information Processing” from the New Zealand Institution of
Education were all used to reviewing the course with the online quizzes on this website. As a result, through comparing the mobile learning application with this e-learning system, researchers should easily be able to locate the pros and cons of mobile learning. These benefits, if any, should be the key to attracting learners to choose mobile learning tools to support their learning activities.

3.2.3 Design of the “Learning beyond Classroom” Application

In this thesis, two types of “Learning beyond Classroom” applications were considered, i.e., “Review” and “Preview”. As shown in Appendix B, the mobile “Review” application begins with the “Welcome” Page, followed by several question pages. Each question page has one question and its related result page. There are five questions in the application.

Instead, the mobile “Preview” application shown in Appendix B began with several pages of notes such as important definitions or case studies about the upcoming lectures. After the pages of notes, the mobile “Preview” application follows exactly the same structure as the mobile “Review” application, i.e., the question pages and result pages.

3.2.4 Questionnaires

The post-questionnaires studies were considered for all the experiments in this thesis. The details of the questionnaires are described in Appendix D.

In Experiment 1, we focused on exploring whether users can easily learn how to use mobile learning applications against the traditional e-learning application. Hence the questionnaire considered five categories: ease to learn, simple usage, convenience,
utility and attitude to use in the future. This type of questionnaire design is well supported by many HCI-related studies (e.g., Szajina, 1996). In contrast, after the first experiment, all of our participants were already familiar with how to use the mobile learning application; we considered ‘Suitability‘ as replacement of ‘Simple usage‘ to see whether the mobile learning application would be well suited to the students’ environment, in particular, beyond the classroom environment.
3.3 Method

3.3.1 Participants

Participants were randomly recruited from the students who enrolled in the “Business Information Processing” at the New Zealand Institution of Education as well as several students from Massey University. They had all taken the same courses about “How to use Microsoft Word to produce documents”. For each experiment, 40 participants were recruited. Table 3.1 shows the number of participants in each experiment.

Table 3.1 The number of participants for each experiment

<table>
<thead>
<tr>
<th>Experiment</th>
<th>Number of Participants</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>40</td>
</tr>
<tr>
<td>2</td>
<td>40</td>
</tr>
<tr>
<td>3</td>
<td>40</td>
</tr>
<tr>
<td>4</td>
<td>40</td>
</tr>
</tbody>
</table>

3.3.2 Experimental Design

The first experiment was to compare mobile learning with e-learning. The participants used a computer connected to the Internet for the Web-based learning; and also used a mobile phone for mobile learning. A within-subject design was hence applied. Note that the same 40 participants were recruited for the following three experiments, i.e., Experiment 2, 3, and 4. To avoid the order effect, in the first experiment, the 40 participants were divided into two groups. The one group firstly took the e-learning system then the mobile learning application; the second group did this in reverse. The details of the first experiment can be found in Table 3.2.
Table 3.2 Experimental design of the first experiment

<table>
<thead>
<tr>
<th>Group</th>
<th>Number of Participants</th>
<th>Experiment Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20</td>
<td>E-learning→ Mobile learning</td>
</tr>
<tr>
<td>2</td>
<td>20</td>
<td>Mobile learning→ E-learning</td>
</tr>
</tbody>
</table>

In Experiment 2, half of the participants (Group 1) used the mobile learning application in a classroom, and the other half (Group 2) out of the classroom. A between-subject design was then applied in this experiment. The details were shown in Table 3.3.

Table 3.3 Experimental design of the second experiment

<table>
<thead>
<tr>
<th>Group</th>
<th>Number of Participants</th>
<th>Experiment Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20</td>
<td>In a classroom</td>
</tr>
<tr>
<td>2</td>
<td>20</td>
<td>Out of the classroom</td>
</tr>
</tbody>
</table>

In Experiment 3, Group 1 used the mobile learning application to review the course just after a lecture was given, and the other half (Group 2) employed the mobile learning application a week later, just before the next lecture. A between-subject design was then applied in this experiment. The details were shown in Table 3.4.
Table 3.4 Experimental design of Experiment 3

<table>
<thead>
<tr>
<th>Group</th>
<th>Number of Participants</th>
<th>Experiment Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20</td>
<td>Just after the lecture</td>
</tr>
<tr>
<td>2</td>
<td>20</td>
<td>A week later, just before the next lecture</td>
</tr>
</tbody>
</table>

Likewise, in Experiment 4, half the participants (Group 1) used the mobile learning application to preview the following lecture, just after a lecture was given, and the other half (Group 2) did the same preview just before the next lecture a week later. A between-subject design was applied in this experiment. The details were shown in Table 3.5.

Table 3.5 Experimental design of Experiment 4

<table>
<thead>
<tr>
<th>Group</th>
<th>Number of Participants</th>
<th>Experiment Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20</td>
<td>day 1 (the day having the previous class)</td>
</tr>
<tr>
<td>2</td>
<td>20</td>
<td>day 2 (the day having the lecture)</td>
</tr>
</tbody>
</table>

These treatments in Experiment 3 and 4 were considered to reveal what ways would more motivate students to benefit from the learning effect with the mobile application given, such as preparation for future learning activities. Table 3.6 summarises the details of all experiments.
Table 3.6 Details of experiment design

<table>
<thead>
<tr>
<th>Experiment</th>
<th>Comparison Trials</th>
<th>Target</th>
<th>Experiment Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>E-learning form vs. mobile learning form</td>
<td>Compare mobile learning with e-learning</td>
<td>Within -Subject</td>
</tr>
<tr>
<td>2</td>
<td>In classroom vs. beyond classroom</td>
<td>Figure out if the location factor affect mobile learning</td>
<td>Between -Subject</td>
</tr>
<tr>
<td>3</td>
<td>Review after the lecture vs. before the next lecture</td>
<td>Find out if the time factor affect mobile learning</td>
<td>Between -Subject</td>
</tr>
<tr>
<td>4</td>
<td>Preview after the previous lecture vs. before the lecture time</td>
<td></td>
<td>Between -Subject</td>
</tr>
</tbody>
</table>

3.3.3 Procedures

In Experiment 1, all the participants were first provided with the instructions regarding both the mobile learning application and the Web-based learning system, including the general information about the experiment and the purposes of the research. In this experiment, participants were first separated into two groups of 20 participants. Group 1 firstly gathered in a computer lab to review the course with the Web-based e-learning application. After this trial, they were required to complete a post questionnaire. They were then asked to use the mobile learning application. The participants could use either the mobile phone given, or their own phones to download the application and run it. After this learning session, they also needed to fill in a post questionnaire. Group 2 took the mobile learning trial first then e-learning with the same experimental procedure.

In Experiment 2, the same 40 participants were divided into two, consisting of 20
people each. The first group used the mobile learning application in a classroom; Group 2 did the application out of the classroom wherever they wanted. This experiment was administered in the lunch time so many of them used the mobile learning application on a bench or in a café.

In Experiments 3 and 4, participants needed to do the review and preview by mobile learning at different times. The details of the different times for the experiments were explained above. In Experiment 3, one group of participants firstly reviewed the course content on the same day as the lecture (Condition A) and the other group reviewed the course content just before the next lecture, i.e., a week later (Condition B). The mobile application was sent by either e-mail or Bluetooth on the lecture days. The participants needed to finish the reviewing within an hour, and were then asked to give back the questionnaires. A week later, Group 2, who were asked to come to the classroom an hour earlier, needed to review through the mobile learning application just before the lecture and gave back the questionnaires at the beginning of the lecture.

In Experiment 4, a group of participants firstly previewed the course content of the next lecture just after the lecture (Condition A) and the other half previewed the content of the next lecture before the next lecture (Condition B). This is expected to reveal which way would motivate their future learning activities the most. Like Experiment 3, the application was sent by e-mail just after the lecture (Group 1). A week later, Group 2 was asked to come to the classroom an hour earlier and completed their preview just before the lecture.
3.4 Data Collection Procedures and Statistical Analysis

Questionnaires were provided for data collection as quantitative measurements. After each trial, participants needed to fill out the questionnaires. The questionnaires offered five point scale evaluation questions. In Experiment 1, there should be an additional final question that asks which solution they prefer after they finish the two comparison tests. The details can be found in Appendix D.

For this study, SPSS 15.0 for Windows was employed to analyse the data collected from each experiment. The data was analysed using Paired-samples T tests and ANalysis Of VAriance (ANOVA). The hypotheses in these experiments were the mean values would be higher than the neutral score (3 on the Likert-point scale) or containing differences in different conditions.
Chapter 4: Results

4.1 Experiment 1

Table 4.1 E-learning vs. m-learning

<table>
<thead>
<tr>
<th>Categories</th>
<th>Approach</th>
<th>Mean</th>
<th>Std. Deviation</th>
<th>t</th>
<th>Sig. (2-tailed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1 Ease to Learn</td>
<td>E-learning</td>
<td>3.80</td>
<td>0.46</td>
<td>-0.53</td>
<td>.599 n.s.</td>
</tr>
<tr>
<td></td>
<td>M-learning</td>
<td>3.85</td>
<td>0.48</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q2 Simple Usage</td>
<td>E-learning</td>
<td>3.53</td>
<td>0.51</td>
<td>-0.70</td>
<td>.486 n.s.</td>
</tr>
<tr>
<td></td>
<td>M-learning</td>
<td>3.57</td>
<td>0.50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q3 Convenience</td>
<td>E-learning</td>
<td>3.23</td>
<td>0.66</td>
<td>-5.34</td>
<td>.000 p&lt;0.01</td>
</tr>
<tr>
<td></td>
<td>M-learning</td>
<td>3.85</td>
<td>0.43</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q4 Utility</td>
<td>E-learning</td>
<td>3.25</td>
<td>0.54</td>
<td>-7.08</td>
<td>.000 p&lt;0.01</td>
</tr>
<tr>
<td></td>
<td>M-learning</td>
<td>4.00</td>
<td>0.45</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q5 Attitude to Use</td>
<td>E-learning</td>
<td>3.10</td>
<td>0.50</td>
<td>-8.20</td>
<td>.000 p&lt;0.01</td>
</tr>
<tr>
<td></td>
<td>M-learning</td>
<td>3.93</td>
<td>0.35</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 4.1 summarised the subjective ratings from Experiment 1, which included the five categories: ease to learn, simple usage, convenience, utility and attitude to use. The results of the experiment are presented for the rating categories respectively. These data were applied to explore whether or not students using mobile learning would perform better than with e-learning. Paired-samples T tests were carried out to compare the mean ratings of each scale between the mobile learning and e-learning trial.
Figure 4.1 Ease to learn

In detail, Figure 4.1 shows the ratings of "Ease to learn" across e-learning and m-learning. The mean rating was 3.80 in e-learning, and m-learning was 3.85. As expected, users could learn the mobile learning application to review the course as easily as the Web-based learning tool did. A Paired-samples T test was used to test whether or not the "Ease to learn" for m-learning and e-learning differed any. As shown in Table 4.1, Paired-samples T test showed there was no significant difference between m-learning and e-learning (t= -0.53, n.s.).
Similar to Figure 4.1, Figure 4.2 shows both mobile learning and e-learning have a similar rating around at 3.5, which means most participants thought the usage of the mobile learning application was as simple as browsing a webpage. A Paired-samples T test also confirmed that there was no significant difference between them (t = -0.70, n.s.) in the "Simple usage" category.
In Figure 4.3, the higher rating was 3.85 in m-learning; and e-learning was 3.23. Obviously, it seemed our participants thought that learning though mobile devices would be more convenient than e-learning. A Paired-samples T test showed there was a significant difference between m-learning and e-learning (t = -5.34, p < 0.05).
Figure 4.4 Utility

Figure 4.4 shows the rating of “Utility” across e-learning and m-learning. The rating of m-learning (mean = 4) was higher than e-learning (mean = 3.25), which means the utility of the mobile learning application might be more attractive to our participants. A Paired-samples T test was applied to prove the significant difference between these two learning approaches ($t = -7.08, p < .05$).
Similar to the previous two figures, Figure 4.5 shows that our participants gave the impression that they would like to use m-learning against e-learning. According to this comparison, most of the participants preferred the mobile learning application to support their learning activities in the future, which would be a clear measure in many studies of the Technology Acceptance Model (Gao, 2005; Koufaris, 2002; Mathieson, 1991; Morris and Dillon, 1997). Through the Paired-samples T test, we compared the mean values of “Attitude to use” between mobile learning and e-learning, revealing a significant difference (t=-8.20, p<0.05).

On the whole, in both the “Ease to learn” and “Simple usage” scales, there were no significant differences; however, our participants seemed to feel mobile learning might be better than e-learning regarding convenience, utility and attitude-to-use. Having said that, most participants were already familiar with the Web-based learning tool; the fact that m-learning approaches achieved a similar level of preference to the Web-based learning system indicates other benefits of the mobile learning application.
would be quite implicative.
4.2 Experiment 2: Comparing Mobile Learning in the Classroom vs. out of the Classroom

From the previous experiment, mobile learning showed certain benefits over e-learning, especially in terms of attitude-to-use. In this experiment, following Experiment 1, we intended to explore whether or not the mobility issue of mobile learning underscores its benefits.

Table 4.2 In the classroom vs. out of the classroom

<table>
<thead>
<tr>
<th>Categories</th>
<th>In the Classroom</th>
<th>Outside the Classroom</th>
<th>F, 38</th>
<th>Sig.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mean</td>
<td>S.D.</td>
<td>Mean</td>
<td>S.D.</td>
</tr>
<tr>
<td>Q1 Ease to Operation</td>
<td>3.95</td>
<td>.39</td>
<td>3.85</td>
<td>.37</td>
</tr>
<tr>
<td>Q2 Suitability</td>
<td>3.10</td>
<td>.55</td>
<td>4.05</td>
<td>.22</td>
</tr>
<tr>
<td>Q3 Convenience</td>
<td>3.35</td>
<td>.59</td>
<td>4.00</td>
<td>.32</td>
</tr>
<tr>
<td>Q4 Utility</td>
<td>3.95</td>
<td>.39</td>
<td>3.85</td>
<td>.49</td>
</tr>
<tr>
<td>Q5 Attitude to Use</td>
<td>3.35</td>
<td>.59</td>
<td>4.15</td>
<td>.37</td>
</tr>
</tbody>
</table>

Table 4.2 summarised the subjective ratings from Experiment 2, which referred to the following five categories: ease of operation, suitability, convenience, utility and attitude to use. Note that we replaced “Simple to use” with “Suitability” in this experiment, partly because the same participants from Experiment 1 were invited again, and mostly because Experiment 2 was carried out to identify whether mobile learning would be suitable “outside the classroom” where many other learning activities would take place. Hence, these data were applied to explore whether the location factor (i.e., in or out of the classroom) would affect the performance of mobile learning activities. The results were described by a one-way ANOVA analysis for each category.
Interestingly, there were no significant differences in terms of ‘utility’ and ‘ease to use’. That is, our participants saw the two different learning contexts, i.e., inside vs. outside, would not determine the benefits of mobile learning.

Yet, the other three ratings were more or less indicative. Figure 4.6 shows the ‘suitability’ issue of mobile learning in the two different contexts. The ‘suitability’ issue focused on exploring whether the mobile learning application would be well suited to learning situations, in particular beyond the classroom environment. The subjective rating of taking the mobile learning application out of the classroom was quite high (mean = 4.05), which was obviously higher than in the classroom (mean = 3.1). A novelty effect might explain this difference. The one-way ANOVA revealed a significant difference (F\(_{1,38}\) = 50.807, p<0.01).

![Figure 4.6 Suitability](image-url)
Figure 4.7 Convenience

Figure 4.7 implies the benefit of mobility, which might lead to convenience to use of a mobile learning application does not have any geographical limitation to use. The subjective rating was 3.35 for mobile learning in the classroom and outside the classroom was 4.00, which was significantly different between in and out of the classroom ($F_{1, 38} = 18.778$, $p < 0.01$).
Likewise, Figure 4.8 depicts our participants looking at the mobile learning application to use it out of the classroom rather than in the classroom environment. A one-way ANOVA test confirmed that there was a significant difference between in and outside the classroom ($F_{1, 38} = 26.725, p<0.01$).

On the whole, our participants seemed to feel mobile learning outside the classroom might be better off than in the classroom in terms of suitability and convenience perspectives. That is, without the restriction of location (i.e., classroom), it can be safely said that users can achieve more benefits and convenience through mobile learning activities.
4.3 Experiment 3: Review with Mobile Learning Applications at Different Times

Building upon Experiment 2 exploring the mobility factor in mobile learning activities, both Experiments 3 and 4 further focused on the time factor, whether this may affect the performance of mobile learning activities out of the classroom. These two experiments were analyzed in the same way as Experiment 2, and administered out of the classroom. Note that Experiment 3 compared review-based learning with mobile devices at different times; and Experiment 4, preview-based learning, which is discussed in the next section.

Table 4.3 Review-based learning at different times

<table>
<thead>
<tr>
<th>Categories</th>
<th>Day 1 (the day having the lecture)</th>
<th>Day 2 (the day having the next lecture)</th>
<th>F₁, 38</th>
<th>Sig.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mean</td>
<td>S.D.</td>
<td>Mean</td>
<td>S.D.</td>
</tr>
<tr>
<td>Q1 Ease to Operation</td>
<td>3.90</td>
<td>.55</td>
<td>3.95</td>
<td>.22</td>
</tr>
<tr>
<td>Q2 Suitability</td>
<td>3.50</td>
<td>.51</td>
<td>3.30</td>
<td>.66</td>
</tr>
<tr>
<td>Q3 Convenience</td>
<td>3.95</td>
<td>.39</td>
<td>3.85</td>
<td>.37</td>
</tr>
<tr>
<td>Q4 Utility</td>
<td>3.75</td>
<td>.44</td>
<td>3.90</td>
<td>.45</td>
</tr>
<tr>
<td>Q5 Attitude to Use</td>
<td>3.55</td>
<td>.51</td>
<td>3.60</td>
<td>.50</td>
</tr>
</tbody>
</table>

Table 4.3 shows the subjective ratings from Experiment 3, which includes the same five scales as Experiment 2. The results of the experiment are presented separately for each category. These data were applied to explore whether the time factor (i.e. the day of the lecture or the day of the next lecture which occurs a week later) would affect the preference of the review-based learning with mobile devices outside the classroom. The each subjective rating was statistically analyzed by a one-way ANOVA test.
According to the subjective ratings as shown in Table 4.3, in all five scales, there were no significant differences between these two trials. This implies that our participants seemed to feel the review-based learning activity with mobile devices might not be affected by when the learning activity occurred.
4.4 Experiment 4: Preview with Mobile Learning Applications at Different Times

To further confirm the findings from Experiment 3, Experiment 4 employed rather different learning activities that would generally take place outside classroom – Preview-based learning with mobile devices at different times.

Table 4.4 Preview-based learning at different times

<table>
<thead>
<tr>
<th>Categories</th>
<th>Day 1 (the day having the lecture)</th>
<th>Day 2 (the day having the next lecture)</th>
<th>$F_{1,38}$</th>
<th>Sig.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mean</td>
<td>S.D.</td>
<td>Mean</td>
<td>S.D.</td>
</tr>
<tr>
<td>Q1 Ease to Operation</td>
<td>3.85</td>
<td>.49</td>
<td>3.95</td>
<td>.51</td>
</tr>
<tr>
<td>Q2 Suitability</td>
<td>4.00</td>
<td>.32</td>
<td>3.85</td>
<td>.37</td>
</tr>
<tr>
<td>Q3 Convenience</td>
<td>3.85</td>
<td>.49</td>
<td>3.90</td>
<td>.31</td>
</tr>
<tr>
<td>Q4 Utility</td>
<td>3.80</td>
<td>.62</td>
<td>3.95</td>
<td>.39</td>
</tr>
<tr>
<td>Q5 Attitude to Use</td>
<td>3.95</td>
<td>.39</td>
<td>3.85</td>
<td>.49</td>
</tr>
</tbody>
</table>

Similar to the results of Experiment 3, Table 4.4 shows that overall five scales, there were no significant differences between these two trials, which again confirmed the results of Experiment 3.
4.5 An Additional Analysis: Review vs. Preview with mobile learning applications

Note that Experiment 3 compared the review-based learning with mobile devices at different times and Experiment 4 for preview-based learning. We further compared these two experiments to figure out whether mobile learning activities outside the classroom might play an important role in improving learners' engagement and motivation.

Table 4.5 Review-based learning vs. preview-based learning

<table>
<thead>
<tr>
<th>Categories</th>
<th>Learning</th>
<th>Mean</th>
<th>Std Deviation</th>
<th>t</th>
<th>Sig. (2-tailed)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Q1 Ease to Operation</td>
<td>Review</td>
<td>3.93</td>
<td>0.42</td>
<td>.330</td>
<td>.753 n.s.</td>
</tr>
<tr>
<td></td>
<td>Preview</td>
<td>3.90</td>
<td>0.50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q2 Suitability</td>
<td>Review</td>
<td>3.40</td>
<td>0.59</td>
<td>-4.891</td>
<td>.000 p&lt;0.01</td>
</tr>
<tr>
<td></td>
<td>Preview</td>
<td>3.93</td>
<td>0.35</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q3 Convenience</td>
<td>Review</td>
<td>3.90</td>
<td>0.38</td>
<td>.330</td>
<td>.743 n.s.</td>
</tr>
<tr>
<td></td>
<td>Preview</td>
<td>3.88</td>
<td>0.40</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q4 Utility</td>
<td>Review</td>
<td>3.83</td>
<td>0.45</td>
<td>-.628</td>
<td>.534 n.s.</td>
</tr>
<tr>
<td></td>
<td>Preview</td>
<td>3.88</td>
<td>0.52</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q5 Attitude to Use</td>
<td>Review</td>
<td>3.58</td>
<td>0.50</td>
<td>-3.911</td>
<td>.000 p&lt;0.01</td>
</tr>
<tr>
<td></td>
<td>Preview</td>
<td>3.90</td>
<td>0.44</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 4.5 shows that the preview-based learning had significantly higher ratings for "Suitability" and "Attitude to use", implying the preview-based learning with mobile devices might be better than review-based mobile learning. That is, mobile learning might be good for motivating students to take part in the learning activities outside the classroom.
Chapter 5: Discussion

This chapter interprets the findings based on the three research questions described in Chapter 2. Table 5.1 summarizes the research questions with answers. The details are represented in the following sections.

Table 5.1 Summary table of research questions and answers

<table>
<thead>
<tr>
<th>Research Questions</th>
<th>Answers</th>
<th>Related Experiments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Would people accept these quiz-form mobile learning applications?</td>
<td>Confirmed.</td>
<td>Experiment 1</td>
</tr>
<tr>
<td>If so, how would they like to use it?</td>
<td>They would like to use it without time and</td>
<td>Experiment 2, 3 and 4</td>
</tr>
<tr>
<td></td>
<td>location limitation.</td>
<td></td>
</tr>
<tr>
<td>2 What benefits would be represented by this &quot;beyond classroom” mobile learning</td>
<td>Convenience and Utility.</td>
<td>Experiment 1</td>
</tr>
<tr>
<td>activity, compared with e-learning?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Whether users can also achieve learning outcomes through m-learning?</td>
<td>Confirmed</td>
<td>Experiment 3 and 4</td>
</tr>
</tbody>
</table>

5.1 Experiment One

The first experiment compared the subjective ratings of the five categories of “Technology Acceptance Model” (Gao, 2005; Koufaris, 2002; Mathieson, 1991; Morris and Dillion, 1997) between e-learning and m-learning. The experimental results confirmed people would accept the quiz-form mobile learning application (the first question depicted in Table 5.1); also the mobile learning activities represented certain benefits over e-learning, particularly for convenience, utility and attitude to use in the future (Research Question 2 depicted in Table 5.1).
Figure 5.1 Comparison between m-learning and e-learning

Figure 5.1 again shows the experimental outcomes of Experiment 1, conceiving many possible explanations. One is that the acceptance of the quiz-form mobile learning application may be confirmed. For the first research question, we tried to figure out the acceptance of mobile learning applications according to the following three hypotheses:

(i) Users can easily learn to use mobile learning applications.

As shown in Figure 5.1, users can easily learn to use the mobile learning application – indeed, as easily as a Web-based learning application, to support learning activities.

(ii) The functionality of the mobile learning applications can achieve the requirement of learning activities.

Figure 5.1 shows that our users thought the utility of mobile learning applications would perform better than e-learning while fulfilling the
requirement of learning activities.

(iii) Users perceive mobile learning activities as convenient and efficient. Through the comparison, one can see that the users applying the mobile learning applications found them to be as simple as the Web-based learning applications.
5.2 Experiment Two

In the second experiment, we explored the mobility issue of m-learning activities outside the classroom.

![Figure 5.2 The result of Experiment 2](image)

The figure above represents the results of Experiment 2. It clearly shows that users preferred to take mobile learning activities outside the classroom, especially considering suitability, convenience and attitude to use. The possible explanation is that users may like to do mobile learning activities in a more ‘mobile’ way. Thanks to the mobility in mobile learning, they may like to carry out their own learning activities without restricting themselves in the classroom, implying this could be a key feature of mobile learning. This referred to the second part of Research Question 1; and partly answered the third research question.
5.3 Experiments Three and Four

Besides the mobility issue of mobile learning, the results of Experiment 3 and 4 suggesting that mobile learning could enhance learners’ engagement and motivation, appear to be the most significant finding in the thesis. It can be said that Figure 5.3 shows the preview-based mobile learning activities were performed better than the review-based, especially in suitability and attitude to use. This also refers back to the first and third research questions.

![Figure 5.3 Additional analysis to compare review vs. preview](image_url)

<table>
<thead>
<tr>
<th></th>
<th>Review-based</th>
<th>Preview-based</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ease to Operation</td>
<td>3.93</td>
<td>3.9</td>
</tr>
<tr>
<td>Suitability</td>
<td>3.4</td>
<td>3.93</td>
</tr>
<tr>
<td>Convenience</td>
<td>3.9</td>
<td>3.88</td>
</tr>
<tr>
<td>Utility</td>
<td>3.83</td>
<td>3.88</td>
</tr>
<tr>
<td>Attitude to Use</td>
<td>3.58</td>
<td>3.9</td>
</tr>
</tbody>
</table>
Chapter 6: Conclusion

6.1 Findings of the Thesis

During the last decade, the adjective ‘mobile’ has become a commonplace descriptor of any social forms. There is general agreement in the literature that the profound impact of Information Technology (IT) and its rapid adoption by individuals, groups, organizations and communities has given rise to the proliferation of ‘mobile societies’.

The field of instructional technology has been no exception, using hard technology (e.g., computer-assisted instruction or mobile learning). When we think of how new technology can support learning, what typically comes to mind is the design of tools and artifacts (e.g., curriculum, assessments, and teaching and learning samples) that the members of a community might effectively use to help them learn. However, we further claim that equally important is consideration of how and when new tools and artifacts are introduced to, and assimilated into, the practice of members of a community. In this regard, this thesis explored whether a text-based mobile learning application could be useful to support users’ learning activities, in particular outside the classroom.

Indeed, from this study, we cannot safely say mobile learning is better than e-learning, or ‘mobility’ can significantly improve people’s learning outcomes. However, at the very least, mobile learning activities can be seen to play apart in people’s learning and especially suitable for learning activities out of the classroom. The main conclusion, therefore, would be people might accept mobile learning activities outside the classroom if well organized.

In addition, in practice, the results suggest the designer of such mobile learning applications needs to ensure users can perceive ‘mobility’. Arguably, though this
needs further investigation, we may conclude that mobile learning would encourage the embedding of learning in students during their daily lives out of the classroom – and motivate them to learn in a more „proactive‘ way. Their active engagement and motivation to learn are, of course, highly relevant to the user’s perception of the content, so that the mobile learning application can be implicative of the appropriate learning subject.
6.2 Implications of this Study

The results of this thesis imply that mobility is a key factor of influencing critical user experiences with new mobile learning activities beyond the classroom. Compared with traditional learning approaches, such as paper-based (or face-to-face lecture-based) and e-learning, the key expectation underlying mobile learning can offer learning mobility without locational and temporal limitations. Future improvements of such mobile learning tools would have to offer users more freedom, allowing them to self-arrange their own learning activities.

Current mobile learning developments usually seem to focus only on applying more advanced or upcoming technologies or services, such as GPRS and other sensing devices through mobile devices. However, considering the practical situations of college education, most students may not be equipped with such advanced mobile phones or they may not want to pay an extra subscription fee. Hence, crucial to the success of mobile learning development, lies on affordable technologies or services, rather than catering for fashion or advanced learning approaches. That is why this thesis considers the text-based mobile learning application, as a more appropriate learning approach satisfying some requirements of users.
6.3 Limitations of the Study

Despite the optimistic conclusions described above, there are still many limitations that need to be addressed in future research. Firstly, from the experimental perspective, inevitably the number of participants and the learning course settings were two main limitations. The sample size was somewhat small so the results may not provide sufficient proof. Furthermore, the learning course, i.e., “How to use a Microsoft Office Word XP to produce documents”, seems too simple, so the learners were not significantly experiencing the requirement of ‘beyond classroom learning’. In future study, we may explore other content more suitably affecting performance of mobile learning activities outside the classroom.

Technical limitations seem to be also noted. One of the main characteristics of Bluetooth is to cover only a relatively short range – typically up to 10 meters. As a result, Bluetooth in our experimental studies was not an effective method of sending applications to the mobile devices, which was why we considered sending the application by e-mail, as an alternative. In addition, most Bluetooth adopted in mobile phones will send the file sequentially, limiting the speed of transmission in our experiment.
6.4 Future Work

The future work would firstly focus on the limitations described above. At the same time, we have been planning to develop some authoring tools for the text-based mobile learning application. As such, these can help the education provider (e.g. lecturers) easily edit the learning content. In addition, future research also explores how to use the “Learning beyond Classroom” application alongside traditional learning and e-learning activities. With rational organization, learners may achieve ideal learning outcomes though this blend of learning pedagogy.
References


Keegan, D. (2002). The future of learning: From eLearning to mLearning. Hagen, Germany: Fern University, Hagen. Institute for Research into Distance Education.


Appendix A: Screenshots of E-learning Tool

1. A new tab will appear on the Ribbon if:
   a. You click the Picture command on the Insert tab.
   b. You select a picture.
   c. You right-click a picture and choose Picture Tools.
   d. Either A or C.

2. Where is the Quick Access Toolbar and when should you use it?
   a. It is in the upper-left corner of the screen, and you should use it for your favorite commands.
   b. It floats above your text, and you should use it when you need to make formatting changes.
   c. It is on the Home tab, and you should use it when you need to quickly launch or start a new document.

3. You can create bulleted lists by using the _____ tab and the _____ group.
   a. Page Layout tab, Paragraph group.
   b. Home tab, Paragraph group.
   c. Insert tab, Symbols group.
   d. Insert tab, Text group.

4. Which corner of the Word window has the zoom control?
   a. Upper-left.
   b. Upper-right.
   c. Lower-left.
   d. Lower-right.

5. The Mini toolbar appears when:
   a. You double-click the active tab on the Ribbon.
   b. You select text.
   c. You select text with the mouse and then point at it.
   d. Any of the above.

This is the first page of the e-learning approach chosen from the Microsoft Office online support website. On this page, five learning questions are offered. Users can tick their answer and click the "Check My Answers" button to go to the next page.
1. A new tab will appear on the Ribbon if:
   
   Your answer: Incorrect.
   
   Correct answer:
   
   a. You select a picture.

   In Word 2007, certain tabs appear only when you need them. For example, let's say you've inserted a picture. But now you want to do more with it. Maybe you want to change how text wraps around it or you want to crop it.

   When you select a picture, the additional Picture Tools appear, with the Format tab showing groups of commands for working with pictures.

   When you click away from the picture, the Picture Tools disappear.

   On-demand tabs appear for other activity areas, too, like tables, drawings, diagrams, and charts.

2. Where is the Quick Access Toolbar and when should you use it?
   
   Your answer: Incorrect.
   
   Correct answer:
   
   a. It is in the upper-left corner of the screen, and you should use it for your favorite commands.

   The Quick Access Toolbar is in the upper-left corner of the screen, above the Ribbon (but you can move it to below the Ribbon if you want — just right-click it and use the commands on the shortcut menu). It contains the commands that you use over and over, every day: Save, Undo, Redo or Repeat, and Print. And you can add your favorite commands to it so that they are available no matter which tab you are on.

The above screenshot shows the second page which is the result and comments page.
Appendix B: Screenshots of “Learning beyond Classroom” Applications

Review

After the “Review” application is installed, the application will appear as shown. The Application named “Review” will show in the Menu page of cell phones. Users can choose “Launch” to activate the application. Then a “Welcome Page” will be displayed.
Information about lecture can be presented on this page. By pressing "Start" the content of the Review should be displayed.

Use the direction buttons on the cell phone to change the choices and validate the choice by pressing the middle of the direction button. "Next" should lead to the result of the first question.

If the choice is correct, the result will show as below.
If the Choice is wrong, the result and comment will be displayed as in the following figure. This result screen will offer users the right answer and some explanation and references.

The “Back” button on the Result pages can go back the related quiz page.

From Question 2, the “Back” button on the Question page can go back to the previews question page as shown in the following figure. The last question result page will have an “Exit” button to quit the application.
Question 2: Where is the Quick Access Toolbar and when should you use it?

- It is in the upper-left corner of the screen, and you should use it for your favorite commands.
- It floats above your text, and you should use it when you need to make formatting changes.
- It is on the Home tab, and you should use it when you need to quickly launch or start a new document.
After installation, the icon of “Preview” will be displayed on the menu screen. As with “Preview”, use “Launch” to activate the application. Also, the “Welcome Page” should be the first screen of this application.

The “Start” button will lead to the notes pages as shown in the following screenshot.
After several Note Pages, the application also offers several preview questions.

Use the direction buttons on the cell phone to change the choices and validate the choice by pressing the middle of the direction button. "Next" should lead to the Result page.
After several questions, the last page should contain some more points to study, named "Future work" page.

The "Exit" button will quit the application.
Appendix C: Source Codes of “Learning beyond Classroom”

Applications

Review

/*
 * MyFirstMobileApp.java
 *
 * Created on 24 March 2007, 13:49
 */

import javax.microedition.midlet.*;
import javax.microedition.lcdui.*;
import javax.microedition.io.*;
import javax.wireless.messaging.*;

/**
 *
 * @author 02370891
 * @version
 */
public class Review extends MIDlet implements CommandListener{

private Form mainForm, Quiz1, Quiz2, Quiz3, Quiz4, Quiz5, Result1, Result2, Result3, Result4, Result5;

private Command exitCommand, backCommand1, backCommand2, backCommand3,
backCommand4, backCommand5, backCommand6,
nextCommand1, nextCommand2, nextCommand3, nextCommand4, nextCommand5,
nextCommand6, nextCommand7, nextCommand8, nextCommand9, nextCommand10;
privateChoiceGroup q1, q2, q3, q4, q5;

public Review (){ }

exitCommand= new Command("Exit", Command.EXIT, 0);
backCommand1= new Command("Back", Command.BACK, 0);
nextCommand1= new Command("Start", Command.CANCEL, 0);
backCommand2= new Command("Back", Command.BACK, 0);
nextCommand2= new Command("Next", Command.CANCEL, 0);
backCommand3= new Command("Back", Command.BACK, 0);
nextCommand3= new Command("Next", Command.CANCEL, 0);
backCommand4= new Command("Back", Command.BACK, 0);
nextCommand4= new Command("Next", Command.CANCEL, 0);
backCommand5= new Command("Back", Command.BACK, 0);
nextCommand5= new Command("Next", Command.CANCEL, 0);
backCommand6= new Command("Back", Command.BACK, 0);
nextCommand6 = new Command("Next", Command.CANCEL, 0);

nextCommand7 = new Command("Next", Command.CANCEL, 0);
//backCommand7 = new Command("Back", Command.BACK, 0);
nextCommand8 = new Command("Next", Command.CANCEL, 0);
//backCommand8 = new Command("Back", Command.BACK, 0);
nextCommand9 = new Command("Next", Command.CANCEL, 0);
//backCommand9 = new Command("Back", Command.BACK, 0);
nextCommand10 = new Command("Next", Command.CANCEL, 0);

q1 = new ChoiceGroup("Question 1: A new tab will appear on the Ribbon if:", Choice.EXCLUSIVE);
q1.append("You click the Picture command on the Insert tab.", null);
q1.append("You select a picture.", null);
q1.append("You right-click a picture and choose Picture Tools.", null);
q1.append("Either A or C.", null);

q2 = new ChoiceGroup("Question 2: Where is the Quick Access Toolbar and when should you use it?", Choice.EXCLUSIVE);
q2.append("It is in the upper-left corner of the screen, and you should use it for your favorite commands.", null);
q2.append("It floats above your text, and you should use it when you need to make formatting changes.", null);
q2.append("It is on the Home tab, and you should use it when you need to quickly launch or start a new document.", null);

q3 = new ChoiceGroup("Question 3: You can create bulleted lists by using the _____ tab and the _____ group.", Choice.EXCLUSIVE);
q3.append("Page Layout tab, Paragraph group.", null);
q3.append("Home tab, Paragraph group.", null);
q3.append("Insert tab, Symbols group.", null);
q3.append("Insert tab, Text group.", null);

q4 = new ChoiceGroup("Question 4: Which corner of the Word window has the zoom control? ", Choice.EXCLUSIVE);
q4.append("Upper-right.", null);
q4.append("Upper-left.", null);
q4.append("Lower-left.", null);
q4.append("Lower-right.", null);

q5 = new ChoiceGroup("Question 5: The Mini toolbar appears when: ", Choice.EXCLUSIVE);
q5.append("You double-click the active tab on the Ribbon.", null);
q5.append("You select text.", null);
q5.append("You select text with the mouse and then point at it.", null);
q5.append("Any of the above.", null);

mainForm = new Form("Welcome Page");
mainForm.append("Welcome to use mobile learning.");
mainForm.addCommand(exitCommand);
mainForm.addCommand(nextCommand1);
mainForm.setCommandListener(this);

Quiz1 = new Form("Review Question");
Quiz1.append("Review Question 1");
Quiz1.append(q1);
Quiz1.addCommand(nextCommand2);
Quiz1.setCommandListener(this);

Result1 = new Form("Result");
Result1.addCommand(backCommand1);
Result1.addCommand(nextCommand3);
Result1.setCommandListener(this);

Quiz2 = new Form("Review Question");
Quiz2.append("Review Question 2");
Quiz2.append(q2);
Quiz2.addCommand(backCommand1);
Quiz2.addCommand(nextCommand4);
Quiz2.setCommandListener(this);

Result2 = new Form("Result");
Result2.addCommand(backCommand2);
Result2.addCommand(nextCommand5);
Result2.setCommandListener(this);

Quiz3 = new Form("Review Question");
Quiz3.append("Review Question 3");
Quiz3.append(q3);
Quiz3.addCommand(backCommand2);
Quiz3.addCommand(nextCommand6);
Quiz3.setCommandListener(this);

Result3 = new Form("Result");
Result3.addCommand(backCommand3);
Result3.addCommand(nextCommand7);
Result3.setCommandListener(this);

Quiz4 = new Form("Review Question");
Quiz4.append("Review Question 4");
Quiz4.append(q4);
Quiz4.addCommand();
Quiz4.addCommand(backCommand3);
Quiz4.addCommand(nextCommand8);
Quiz4.setCommandListener(this);

        Result4= new Form("Result");
Result4.addCommand(backCommand4);
Result4.addCommand(nextCommand9);
Result4.setCommandListener(this);

        Quiz5= new Form("Review Question");
Quiz5.append("Review Question 5");

Quiz5.append(q5);
Quiz5.addCommand(backCommand4);
Quiz5.addCommand(nextCommand10);
Quiz5.setCommandListener(this);

        Result5= new Form("Result");
Result5.addCommand(backCommand5);
Result5.addCommand(exitCommand);
Result5.setCommandListener(this);

    }

public void startApp() {
    Display.getDisplay(this).setCurrent(mainForm);
}

public void pauseApp() {
}

public void destroyApp(boolean unconditional) {
    notifyDestroyed();
}

public void commandAction(Command c, Displayable s){
    if(c== exitCommand)
    {
        destroyApp(true);
    }
    else if (c== backCommand1)
    {
        Display.getDisplay(this).setCurrent(Quiz1);
    }
    else if (c== backCommand2)
    {
        Display.getDisplay(this).setCurrent(Quiz2);
    }
    else if (c== backCommand3)
Display.getDisplay(this).setCurrent(Quiz3);
}
else if (c== backCommand4)
{
Display.getDisplay(this).setCurrent(Quiz4);
}
else if (c== backCommand5)
{
Display.getDisplay(this).setCurrent(Quiz5);
}
else if (c== nextCommand1)
{
Display.getDisplay(this).setCurrent(Quiz1);
}
else if (c== nextCommand2)
{
Display.getDisplay(this).setCurrent(Result1);
if (q1.getSelectedIndex() == 1)
{
 Result1.append("Correct");
}
else
{
 Result1.append("The correct answer is (b). In Word 2007, certain tabs appear only when you need them. For example, let's say you've inserted a picture but now you want to do more with it. Maybe you want to change how text wraps around it or you want to crop it."

"When you select a picture, the additional Picture Tools appear, with the Format tab showing groups of commands for working with pictures."

"When you click away from the picture, the Picture Tools disappear." +

"On-demand tabs appear for other activity areas, too, like tables, drawings, diagrams, and charts."
);
}
else if (c== nextCommand3)
{
Display.getDisplay(this).setCurrent(Quiz2);
}
else if (c== nextCommand4)
{
Display.getDisplay(this).setCurrent(Result2);
if (q2.getSelectedIndex() == 0)
{
 Result2.append("Correct");
}
The Quick Access Toolbar is in the upper-left corner of the screen, above the Ribbon (but you can move it to below the Ribbon if you want — just right-click it and use the commands on the shortcut menu). It contains the commands that you use over and over, every day: Save, Undo, Redo or Repeat, and Print. And you can add your favorite commands to it so that they are available no matter which tab you are on.

Once you have a document open and have typed your text, you'll no doubt want to format that text. Many familiar formatting commands are in view on the Home tab: Bold, Italic, Font Size, and so on and there are several more you'll find useful here.

In the Paragraph group, you have the ever-popular bulleted lists, numbered lists, and multilevel lists. You've also got your indentation and alignment commands here.
Result4.append("The correct answer is (d). ") + "After you insert something, you may need a closer look at its details. So you'll definitely want to know where you zoom."

+ "Look in the lower-right corner. Drag the slider to the right to zoom in, and drag it to the left to zoom out."

+ "The Zoom command is available on the View tab, too."

else if (c== nextCommand9)
    
    Display.getDisplay(this).setCurrent(Quiz5);

else if (c== nextCommand10)
    
    Display.getDisplay(this).setCurrent(Result5);
    if (q5.getSelectedIndex() == 2)
        
        Result5.append("Correct");

else
    
    Result5.append("The correct answer is (c). " + "Some formatting commands are so useful that you want to have them available whatever you're doing."

+ "For example, let's say you're working on the Page Layout tab, and you want to quickly format some text. You could click the Home tab to see the formatting options, but here's a faster way."

+ "Select your text and then point at the selection. The Mini toolbar appears in a faded fashion. If you point at the Mini toolbar, it becomes solid, and you can click a formatting option there."

+ "The Mini toolbar is great for formatting options, but what if you want other types of commands to always be available? Use the Quick Access Toolbar."}
import javax.microedition.midlet.*;
import javax.microedition.lcdui.*;
import javax.microedition.io.*;
import javax.wireless.messaging.*;

public class Preview extends MIDlet implements CommandListener{

private Form mainForm, Quiz1, Quiz2, Result1, Result2, Futurework;
private Form Note1, Note2;
private Command exitCommand, backCommand1, backCommand2, backCommand3,
backCommand4, backCommand5,
nextCommand1, nextCommand2, nextCommand3, nextCommand4, nextCommand5,
nextCommand6, nextCommand7;

public Preview(){
exitCommand= new Command("Exit", Command.EXIT, 0);
backCommand1= new Command("Back", Command.BACK, 0);
nextCommand1= new Command("Start", Command.CANCEL, 0);
backCommand2= new Command("Back", Command.BACK, 0);
nextCommand2= new Command("Next", Command.CANCEL, 0);
backCommand3= new Command("Back", Command.BACK, 0);
nextCommand3= new Command("Next", Command.CANCEL, 0);
backCommand4= new Command("Back", Command.BACK, 0);
nextCommand4= new Command("Next", Command.CANCEL, 0);
backCommand5= new Command("Back", Command.BACK, 0);
nextCommand5= new Command("Next", Command.CANCEL, 0);
nextCommand6= new Command("Next", Command.CANCEL, 0);
nextCommand7= new Command("Next", Command.CANCEL, 0);

//txtName = new TextField("User Name", ",", 20, TextField.ANY);
//txpassword = new TextField("Password", ",", 20, TextField.PASSWORD);
q1 = new ChoiceGroup("Question 1: You want to use the Copy and Paste commands to work with text. Where do you find them on the Ribbon?", Choice.EXCLUSIVE);
q1.append("Insert tab.", null);
q1.append("Home tab.", null);
q1.append("Quick Access Toolbar.", null);
//q1.append("I AM", null);

q2 = new ChoiceGroup("Question 2: You are adding a new slide that you'll need to insert a picture onto. Which of these layouts should you choose?", Choice.EXCLUSIVE);
q2.append("Blank.", null);
q2.append("Title and Content.", null);
q2.append("Title Only.", null);
//q2.append("I AM", null);

mainForm = new Form("Welcome Page");
mainForm.append("Welcome to use the Beaming Preview.");
mainForm.addCommand(exitCommand);
mainForm.addCommand(nextCommand1);
mainForm.setCommandListener(this);

Note1 = new Form("Case");
Note1.append("Upper case and lower case text is familiar to you but there is also Sentence case (only the first word of sentence capitalized) and Title case (first letter of all words capitalized, as in –Bulls Soccer Club”).");
Note1.addCommand(backCommand1);
Note1.addCommand(nextCommand2);
Note1.setCommandListener(this);

Note2 = new Form("Cut, copy and paste from clipboard ");
Note2.append("Moving or copying pieces of text from one place to another in your document is called cut, copy and paste.");
Note2.addCommand(backCommand2);
Note2.addCommand(nextCommand3);
Note2.setCommandListener(this);

Quiz1 = new Form("Preview Question");
Quiz1.append("Preview Question 1");
Quiz1.append(q1);
Quiz1.addCommand(backCommand3);
Quiz1.addCommand(nextCommand4);
Quiz1.setCommandListener(this);

Result1 = new Form("Result");
Result1.addCommand(backCommand4);
Result1.addCommand(nextCommand5);
Result1.setCommandListener(this);

Quiz2= new Form("Preview Question");
Quiz2.append("Preview Question 2");
Quiz2.append(q2);
Quiz2.addCommand(backCommand4);
Quiz2.addCommand(nextCommand6);
Quiz2.setCommandListener(this);

Result2= new Form("Result");
Result2.addCommand(backCommand5);
Result2.addCommand(nextCommand7);
Result2.setCommandListener(this);

Futurework= new Form ("Future work");
Futurework.append("Step by step - Create a new document and save it. "+"\n"+ "Step by step - Retrieve your file, then close it. "+"\n"
+"Step by step – margins, portrait/landscape."
); Futurework.addCommand(exitCommand);
Futurework.addCommand(backCommand4);
Futurework.setCommandListener(this);

public void startApp() {
Display.getDisplay(this).setCurrent(mainForm);
}

public void pauseApp() {
}

public void destroyApp(boolean unconditional) {
notifyDestroyed();
}

public void commandAction(Command c, Displayable s){
if(c== exitCommand)
{
destroyApp(true);
}
else if (c== backCommand1)
{
Display.getDisplay(this).setCurrent(mainForm);
}
else if (c== backCommand2)
{
Display.getDisplay(this).setCurrent(Note1);
}
else if (c== backCommand3)
    {
        Display.getDisplay(this).setCurrent(Note2);
    }
else if (c== backCommand4)
    {
        Display.getDisplay(this).setCurrent(Quiz1);
    }
else if (c== backCommand5)
    {
        Display.getDisplay(this).setCurrent(Quiz2);
    }
else if (c== nextCommand1)
    {
        Display.getDisplay(this).setCurrent(Note1);
    }
else if (c== nextCommand2)
    {
        Display.getDisplay(this).setCurrent(Note2);
    }
else if (c== nextCommand3)
    {
        Display.getDisplay(this).setCurrent(Quiz1);
    }
else if (c== nextCommand4)
    {
        Display.getDisplay(this).setCurrent(Result1);
        if (q1.getSelectedIndex() == 1)
            {
                Result1.append("Correct");
            }
        else
            {
                Result1.append("The correct answer is b"+
                "The set of most-used commands extends across the first layer, or tab, of the Ribbon, called the Home tab. These commands support typical tasks, including copying and pasting, adding slides, formatting text and paragraphs, working with shapes, and finding and replacing text.");
                //Result1.append(new Integer(q1.getSelectedIndex()).toString());
            }
    }
else if (c== nextCommand5)
    {
        Display.getDisplay(this).setCurrent(Quiz2);
    }
else if (c== nextCommand6)
    {
        Display.getDisplay(this).setCurrent(Result2);
        if (q2.getSelectedIndex() == 1)
else
{
  Result2.append("The correct answer is b" + 
                  "n" + "If you know you'll want to insert a
picture or other type of graphic, such as a table or chart, on the slide, choose a 'content'
type of layout. These layouts contain one or more placeholders (the large boxes with a
dotted border that content goes into) that support a range of content types, either text or
a table, diagram, chart, picture, clip art, or media file. These content placeholders are
recognizable when you're choosing a layout, from the layout gallery, because they
contain a group of icons that represent all the content types. Layouts that contain
content placeholders include Title and Content, Two Content, and Content with Caption,
among others.");
  //Result2.append(new Integer(q2.getSelectedIndex()).toString());
}
else if (c == nextCommand7)
{
  Display.get Display(this).set Current (Futurework);
}
}
Appendix D: Questionnaires

Experiment 1: Questionnaires (E-learning vs. Mobile Learning)

Please fill the following questions (1 = Strongly Disagree, 5 = Strongly Agree)

1. The application is easy to learn to use.
   1                2             3            4           5

2. It is simple to use the tool to facilitate the learning.
   1                2             3            4           5

3. It makes the beyond classroom learning more convenient.
   1                2             3            4           5

4. The utility of this tool can fulfil the need of learning activities.
   1                2             3            4           5

5. I would like to use this way to do the beyond classroom learning in the future.
   1                2             3            4           5

Which way do you prefer to do in the future, e-learning approach or mobile learning way?

☐E-learning ☐Mobile learning ☐No difference
Experiment 2: Questionnaires (In classroom vs. Beyond classroom)

Please fill the following questions (1 = Strongly Disagree, 5 = Strongly Agree)

1. Mobile learning can be easily operated under the situation (In classroom/ Beyond classroom).
   1           2           3           4           5

2. Mobile learning would be suitable to use under the situation.
   1           2           3           4           5

3. It makes the learning activities more convenient.
   1           2           3           4           5

4. The functions of the mobile learning tool can fulfil your requirement for learning.
   1           2           3           4           5

5. I would like to use this way to do the learning activities in the future.
   1           2           3           4           5
Experiment 3&4: Questionnaires (Different Time)

Please fill the following questions (1 = Strongly Disagree, 5 = Strongly Agree)

1. Mobile learning can be easily operated at this time.
   1                2             3            4           5

2. Mobile learning would be suitable to operate at this time.
   1                 2             3            4           5

3. It makes the review/preview more convenient.
   1                 2             3            4           5

4. The utility of this mobile learning tool can support the preview/review at this time.
   1                 2             3            4           5

5. I would like to do the review or preview at this time in the future.
   1                 2             3            4           5